Quartus Il Introduction Using VHDL Design

This tutorial presents an introduction to the Qua@ﬁi CAD system. It gives a general overview of a typi-
cal CAD flow for designing circuits that are implemented byngsFPGA devices, and shows how this flow is
realized in the Quartus Il software. The design processuistibted by giving step-by-step instructions for using
the Quartus Il software to implement a very simple circuiamAltera FPGA device.

The Quartus Il system includes full support for all of the plgp methods of entering a description of the
desired circuit into a CAD system. This tutorial makes usthefVHDL design entry method, in which the user
specifies the desired circuit in the VHDL hardware desariptanguage. Two other versions of this tutorial are
also available; one uses the Verilog hardware descriptingdage and the other is based on defining the desired
circuitin the form of a schematic diagram.

The last step in the design process involves configuring ésigded circuit in an actual FPGA device. To
show how this is done, it is assumed that the user has accwsAdtera DE2 Development and Education board
connected to a computer that has Quartus Il software iastalh reader who does not have access to the DE2
board will still find the tutorial useful to learn how the FP@#ogramming and configuration task is performed.

The screen captures in the tutorial were obtained using theatQs Il version 5.0; if other versions of the
software are used, some of the images may be slightly diftere

Contents:

Typical CAD flow

Getting started

Starting a New Project

VHDL Design Entry

Compiling the Design

Pin Assignment

Simulating the Designed Circuit

Programming and Configuring the FPGA Device
Testing the Designed Circuit



Computer Aided Design (CAD) software makes it easy to imgeta desired logic circuit by using a pro-
grammable logic device, such as a field-programmable gedg @FPGA) chip. A typical FPGA CAD flow is
illustrated in Figure 1.
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Figure 1. Typical CAD flow.

The CAD flow involves the following steps:

e Design Entry — the desired circuit is specified either by means of a schierdagram, or by using a
hardware description language, such as VHDL or Verilog

e Synthesis-the entered design is synthesized into a circuit that stasf the logic elements (LES) provided
in the FPGA chip

e Functional Simulation — the synthesized circuit is tested to verify its functiot@irectness; this simulation
does not take into account any timing issues



e Fitting — the CAD Fitter tool determines the placement of the LEs @efiim the netlist into the LEs in
an actual FPGA chip; it also chooses routing wires in the thimake the required connections between
specific LEs

e Timing Analysis — propagation delays along the various paths in the fittedlitiare analyzed to provide
an indication of the expected performance of the circuit

e Timing Simulation — the fitted circuit is tested to verify both its functionarmctness and timing

e Programming and Configuration — the designed circuit is implemented in a physical FPGA tlyijpro-
gramming the configuration switches that configure the LEbkemtablish the required wiring connections

This tutorial introduces the basic features of the Quartssftware. It shows how the software can be used to
design and implement a circuit specified by using the VHDLdhare description language. It makes use of the
graphical user interface to invoke the Quartus Il commabdsng this tutorial, the reader will learn about:

e Creating a project

Design entry using VHDL code

Synthesizing a circuit specified in VHDL code

Fitting a synthesized circuit into an Altera FPGA

Assigning the circuit inputs and outputs to specific pinsttnEPGA

Simulating the designed circuit

Programming and configuring the FPGA chip on Altera’s DE2rdoa

1 Getting Started

Each logic circuit, or subcircuit, being designed with Quail software is called aroject The software works
on one project at a time and keeps all information for thajgmtdn a single directory (folder) in the file system.
To begin a new logic circuit design, the first step is to creatirectory to hold its files. To hold the design files
for this tutorial, we will use a directorintrotutorial. The running example for this tutorial is a simple circuit fo
two-way light control.

Start the Quartus Il software. You should see a display amtd the one in Figure 2. This display consists
of several windows that provide access to all the featur&duzfrtus Il software, which the user selects with the
computer mouse. Most of the commands provided by Quartustilare can be accessed by using a set of menus
that are located below the title bar. For example, in Figuclicking the left mouse button on the menu named
File opens the menu shown in Figure 3. Clicking the left mouseobutin the entrnjExit exits from Quartus Il
software. In general, whenever the mouse is used to selewthong, thdeft button is used. Hence we will not
normally specify which button to press. In the few cases whismecessary to use thigght mouse button, it will
be specified explicitly.
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Figure 2. The main Quartus Il display.
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Figure 3. An example of the File menu.



For some commands it is necessary to access two or more nreseguience. We use the conventidenul
> Menu2 > Item to indicate that to select the desired command the userdffiost click the left mouse button
on Menul, then within this menu click oMenu2, and then withirMenu?2 click on Item. For exampleFile >
Exit uses the mouse to exit from the system. Many commands candieeith by clicking on an icon displayed in
one of the toolbars. To see the command associated with anposition the mouse over the icon and a tooltip
will appear that displays the command name.

1.1 Quartus Il Online Help

Quartus Il software provides comprehensive online docuatiem that answers many of the questions that may
arise when using the software. The documentation is actéss®a the menu in thélelp window. To get some
idea of the extent of documentation provided, it is worthHe/fior the reader to browse through tHelp menu.
For instance, selectingelp > How to Use Help gives an indication of what type of help is provided.

The user can quickly search through the Help topics by setgktelp > Search, which opens a dialog box
into which key words can be entered. Another method, corgemsitive help, is provided for quickly finding
documentation for specific topics. While using most apfilices, pressing th€1 function key on the keyboard
opens a Help display that shows the commands availabledapplication.

2 Starting a New Project

To start working on a new design we first have to define a design project Quartus Il software makes the
designer’s task easy by providing support in the form wizard Create a new project as follows:

1. Selectrile > New Project Wizard to reach the window in Figure 4, which indicates the capighilf this
wizard. You can skip this window in subsequent projects bgcking the boxDon’t show me this intro-
duction again. PressNext to get the window shown in Figure 5.

New Project Wizard: Introduction

The Mew Project “Wizard helps you create a new project and preliminary project settings,
including the following:

#  Project name and directory

#  Mame of the top-level design entity
#  Project files and libraries

#  Target device family and device
# EDA tool settings

*f'ou can change the settings for an existing project and specify additional project-wide
zettings with the Settings command [Assignments menu). You can uge the various
pages of the Settings dialog box to add functionality to the project.

™ Don't show me this introduction again

| Mest > | | Cancel |

Figure 4. Tasks performed by the wizard.
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Figure 5. Creation of a new project.

2. Set the working directory to bietrotutorial; of course, you can use some other directory name of your
choice if you prefer. The project must have a name, whichusilisthe same as the top-level design entity
that will be included in the project. Chookght as the name for both the project and the top-level entity, as
shown in Figure 5. Presdext. Since we have not yet created the direciatyotutorial, Quartus Il software

displays the pop-up box in Figure 6 asking if it should crehtedesired directory. Clickes, which leads
to the window in Figure 7.

GQuartus 11 [x]

& Directory "D:/Antrotutorial” does not exist, Do you want to create it?

e [ls] |

Figure 6. Quartus Il software can create a new directorytfergroject.



New Project Wizard: Add Files [page 2 of 5] El

Select the design files you want to include in the project. Click Add All to add all design files
in the project directory to the project. Mote: you can alwaps add design files to the project
later.

File name: || J

File name Type Add Al

" LEEERE

Specify the path names of any non-default libraries. User Libraries...

< Back | Mest > | Finizh | Cancel |

Figure 7. The wizard can include user-specified design files.

3. The wizard makes it easy to specify which existing fileali§) should be included in the project. Assuming
that we do not have any existing files, clislext, which leads to the window in Figure 8.

New Project Wizard: Family & Device Settings [p... El

Select the family and device you want to target for compilation.

Family: Cyclone Il j
Target device
" Auto device selected by the Fitter from the Sevailable devices' list

+ Specific device selected in ‘Available devices' list

Available devices:
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Filters

< Back | Mest > | Finizh | Cancel |

Figure 8. Choose the device family and a specific device.



4. We have to specify the type of device in which the desigimedit will be implemented. Choose Cycloh¥
Il as the target device family. We can let Quartus Il softwegkect a specific device in the family, or we can
choose the device explicitly. We will take the latter apmtoa-rom the list of available devices, choose the
device called EP2C35F672C6 which is the FPGA used on A#®&?2 board. Predsext, which opens the
window in Figure 9.

New Project Wizard: EDA Tool Settings [page 4 of...@]

Specify the other EDA tools - in addition to the Quartus || software - used with the project.

™ EDA design entry /
synthesis toal: | J
-
[~ EDA simulation toal: | J
-
™ EDA timing analysis tool: | J
-

< Back | Mest > | Finizh | Cancel |

Figure 9. Other EDA tools can be specified.

5. The user can specify any third-party tools that shoulddeslu A commonly used term for CAD software
for electronic circuits i€£DA tools where the acronym stands for Electronic Design Automafidris term
is used in Quartus Il messages that refer to third-partystaghich are the tools developed and marketed
by companies other than Altera. Since we will rely solely ara@us Il tools, we will not choose any other
tools. Presdext.

6. A summary of the chosen settings appears in the screemshdvigure 10. PresBinish, which returns to
the main Quartus Il window, but witlight specified as the new project, in the display title bar, ascateid
in Figure 11.



New Project Wizard: Summary [page 5 of 5]

‘wihen vou click Finish, the project will be created with the following settings:

Project directory:
[: fintrotutorial!

Froject name: light
Top-level design entity: light
Mumber of files added: 1]

Mumber of user libraries added: 0

Device assignments:

Family name: Cyclone ||

Device: EP2C35FET2CE
ED& tools:

Dresign entry/spnthesis: <Mone>

Simulatior: <Mone:

Timing analysiz: <Mone>

< Back | et > I Finizh I Cancel |

Figure 10. Summary of the project settings.
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Figure 11. The Quartus Il display for the created project.



3 Design Entry Using VHDL Code

As a design example, we will use the two-way light contratiiecuit shown in Figure 12. The circuit can be used
to control a single light from either of the two switches,andz,, where a closed switch corresponds to the logic
value 1. The truth table for the circuit is also given in theifig Note that this is just the Exclusive-OR function

of the inputsz; andx,, but we will specify it using the gates shown.
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Figure 12. The light controller circuit.

The required circuit is described by the VHDL code in Figuge Mote that the VHDL entity is callelight to
match the name given in Figure 5, which was specified whenrtbjeqi was created. This code can be typed into
a file by using any text editor that stores ASCII files, or byngsihe Quartus Il text editing facilities. While the
file can be given any name, it is a common designers’ praaticsé the same name as the name of the top-level
VHDL entity. The file name must include the extensigni, which indicates a VHDL file. So, we will use the
namelight.vhd

LIBRARY ieee;
USE ieee.stdogic_1164.all ;
ENTITY light IS
PORT (x1,x2:IN STDLOGIC;
f :OUT STD.LOGIC);
END light ;

ARCHITECTURE LogicFunction OF light IS
BEGIN

f <= (x1 AND NOT x2) OR (NOT x1 AND x2);
END LogicFunction ;

Figure 13. VHDL code for the circuit in Figure 12.

3.1 Using the Quartus Il Text Editor

This section shows how to use the Quartus Il Text Editor. Yauskip this section if you prefer to use some other
text editor to create the VHDL source code file, which we wahmelight.vhd

SelectFile > New to get the window in Figure 14, choos#1DL File, and clickOK. This opens the Text
Editor window. The first step is to specify a name for the filattill be created. Seleétile > Save As to open
the pop-up box depicted in Figure 15. In the box labedade as type chooseVHDL File. In the box labeled
File name typelight. Put a checkmark in the boxdd file to current project. Click Save, which puts the file
into the directornyintrotutorial and leads to the Text Editor window shown in Figure 16. Maxirthe Text Editor
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window and enter the VHDL code in Figure 13 into it. Save the ffiy typingFile > Save, or by typing the
shortcutCtrl-s.

New X

Device Design Files l Software Files ] Other Files ]

AHDL File

Block Diagram/S chematic File
EDIF File

Veriloi HOL File

Cancel

Figure 14. Choose to prepare a VHDL file.

Save in; |E} introtutorial ﬂ EF '
db
File name: ligh
Save as type: |WHDL File (*.vhd.” vhd] =] Cancel
Iv Add file to current project

Figure 15. Name the file.

# light.vhd

M=

|~

|

Figure 16. Text Editor window.
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Most of the commands available in the Text Editor are sejfl@xatory. Text is entered at thesertion point
which is indicated by a thin vertical line. The insertion piotan be moved either by using the keyboard arrow
keys or by using the mouse. Two features of the Text Editoreapecially convenient for typing VHDL code.
First, the editor can display different types of VHDL statts in different colors, which is the default choice.
Second, the editor can automatically indent the text on alimevgo that it matches the previous line. Such options
can be controlled by the settingsTnols > Options > Text Editor.

3.1.1 Using VHDL Templates

The syntax of VHDL code is sometimes difficult for a desigrerémember. To help with this issue, the Text
Editor provides a collection o¥HDL templates The templates provide examples of various types of VHDL
statements, such as an ENTITY declaration, a CASE stateraadtassignment statements. It is worthwhile
to browse through the templates by selectidjt > Insert Template > VHDL to become familiar with this
resource.

3.2 Adding Design Files to a Project

As we indicated when discussing Figure 7, you can tell Qudttsoftware which design files it should use as part
of the current project. To see the list of files already ineldith thelight project, selecAssignments > Settings,
which leads to the window in Figure 17. As indicated on thé dede of the figure, click on the itefffiles. An
alternative way of making this selection is to cho&seject > Add/Remove Files in Project.

Settings - light @
Category:
General
Files
User Libraries [Current Project] Select the desion files you want to include in the project. Click Add All to add all design files in the
Device praject directory ta the praject.

Timing Requirements & Options
EDA Tool Settings . )

File: narne: J
Compilation Process Settings
Analysis & Synthesis Settings File name Type Add 2l
Fitter Settings light. vhd WHDL File
Tirning Analyzer
Diesign Assistant
SignalT ap Il Logic Analyzer
SignalProbe Settings
Simulator
PowerPlay Power Analyzer Settings
Software Build Settings
HardCapy Settings

ULl

F

F

oK Cancel

Figure 17. Settings window.

If you used the Quartus Il Text Editor to create the file andckkd the box labeleddd file to current
project, as described in Section 3.1, then tight.vhdfile is already a part of the project and will be listed in the
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window in Figure 17. Otherwise, the file must be added to tlogegt. So, if you did not use the Quartus Il Text
Editor, then place a copy of the filght.vhd which you created using some other text editor, into theatdry
introtutorial. To add this file to the project, click on tikéle name: button in Figure 17 to get the pop-up window
in Figure 18. Select thight.vhdfile and clickOpen. The selected file is how indicated in the Files window of
Figure 17. ClickOK to include thdight.vhdfile in the project. We should mention that in many cases thartga

Il software is able to automatically find the right files to diseeach entity referenced in VHDL code, even if the
file has not been explicitly added to the project. Howeverctamplex projects that involve many files it is a good
design practice to specifically add the needed files to thiegas described above.

Select File X

Loak in: |_} intratutorial ﬂ £ B

File name: |Iight.vhd
Files of type: |Design Files [".tdf;".vhd;".vhdl;".v;".vlg;".vh;:j Cancel

Figure 18. Select the file.

4 Compiling the Designed Circuit

The VHDL code in the fildight.vhdis processed by several Quartus Il tools that analyze the,@ohthesize
the circuit, and generate an implementation of it for thgeachip. These tools are controlled by the application
program called th€ompiler

Run the Compiler by selectingrocessing > Start Compilation, or by clicking on the toolbar ico ® that
looks like a purple triangle. As the compilation moves thglowarious stages, its progress is reported in a window
on the left side of the Quartus Il display. Successful (orugnsssful) compilation is indicated in a pop-up box.
Acknowledge it by clickingOK, which leads to the Quartus Il display in Figure 19. In the sage window, at the
bottom of the figure, various messages are displayed. Inafaseors, there will be appropriate messages given.

When the compilation is finished, a compilation report isduced. A window showing this report is opened
automatically, as seen in Figure 19. The window can be résim@ximized, or closed in the normal way, and it

can be opened at any time either by selecBngcessing > Compilation Report or by clicking on the icor€ .

The report includes a number of sections listed on the ld# sif its window. Figure 19 displays the Compiler
Flow Summary section, which indicates that only one log@rednt and three pins are needed to implement this
tiny circuit on the selected FPGA chip. Another section igvehin Figure 20. Itis reached by selectiAgalysis

& Synthesis > Equations on the left side of the compilation report. Here we see th&legpressions produced
by the Compiler when synthesizing the designed circuit.eDlesthatf is the output derived as

f=x2%x1

where the $ sign is used to represent the Exclusive-OR aperaDbviously, the Compiler recognized that the
logic expression in our design file is equivalent to this esgron.
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Figure 19. Display after a successful compilation.
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Figure 20. Compilation report showing the synthesized gons

4.1 Errors

Quartus Il software displays messages produced duringitatiop in the Messages window. If the VHDL design
file is correct, one of the messages will state that the catipil was successful and that there are no errors.

If the Compiler does not report zero errors, then there isadtlone mistake in the VHDL code. In this case
a message corresponding to each error found will be disglaythe Messages window. Double-clicking on an
error message will highlight the offending statement in\t#DL code in the Text Editor window. Similarly, the
Compiler may display some warning messages. Their detaiide explored in the same way as in the case of
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error messages. The user can obtain more information atspéafic error or warning message by selecting the
message and pressing thg function key.

To see the effect of an error, open the fight.vhd Remove the semicolon in the statement that defines the
function f, illustrating a typographical error that is easily madenpde the erroneous design file by clicking on
the ® icon. A pop-up box will ask if the changes made to tight.vhdfile should be saved; clickes. After
trying to compile the circuit, Quartus Il software will disly a pop-up box indicating that the compilation was not
successful. Acknowledge it by clickif@K. The compilation report summary, given in Figure 21, nowftors
the failed result. Expand th&nalysis & Synthesis part of the report and then selddiessages to have the
messages displayed as shown in Figure 22. Double-clickefirgt error message. Quartus Il software responds
by opening thdight.vhdfile and highlighting the statement which is affected by ther as shown in Figure 23.
Correct the error and recompile the design.

© Compilation Report - Flow Summary

@ Compilation Report Flow Summary

& B Legal Notice
@E Flow Summary Flows Status Flows Failed - Tue Aug 09 13:42:09 2005
5B Flow Settings Quartusz Il Yersion 5.0 Build 168 06/22/2005 5P 1 SJ Full Wersion
@5 Flow Elapsed Time Fievizion Mame light
@ Flow Log Top-level Entity Mame light
&7 Analysis & Synthesis | Family Cyclone |l
Device EP2C35FET2CE
Timing Models Preliminary
Met timing requirements  MAA

Figure 21. Compilation report for the failed design.
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; Errar: WHOL sprtax emar at light.vhd[12) near text "END"': expecting "

SHEE Flow Elapsed Timea ad

@ Flow Log fé) Info: Found 0 design units, including O entities, in source file light. vhd

0 Ermor: Quartuz || Analysiz & Synthesiz was unsuccessful. 1 eror, 0 warmings

- &F 3 dnalysis 8 Synthesis

& summary
+ &1 Settings
&8 Source Files Read
' i) Messages Message: 0 of 10 ¥ | J

Figure 22. Error messages.

& light.vhd CEX
LIBERARY ieee ;
USE ieee.std logic_1164.all ;

ENTITY light IS
PORT { =1, x2 : IN STD_LOGIC ;
£ : OUT  STD_LOGIC )
END light ;

ARCHITECTURE LogicFunction OF light IS
EEGIN
£ <= {x1 AND NOT x2) OR (MOT x1 AND xZj

END LogicFunction ;

Figure 23. Identifying the location of the error.
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5 Pin Assignment

During the compilation above, the Quartus Il Compiler wa®fto choose any pins on the selected FPGA to serve
as inputs and outputs. However, the DE2 board has hardwinatections between the FPGA pins and the other
components on the board. We will use two toggle switchegléats W, andSW,, to provide the external inputs,
x1 andxs, to our example circuit. These switches are connected tBRIGRA pins N26 and N25, respectively. We
will connect the outpuyf to the green light-emitting diode labeléd” DG, which is hardwired to the FPGA pin
AE22.

Pin assignments are made by using the Assignment Editact@esignments > Pins to reach the window
in Figure 24. UndeCategory selectPin. Double-click on the entrg. <new>> which is highlighted in blue in
the column labeled To. The drop-down menu in Figure 25 willear. Click onr1 as the first pin to be assigned;
this will enterz1 in the displayed table. Follow this by double-clicking o thox to the right of this new1
entry, in the column labeled Location. Now, the drop-dowmma Figure 26 appears. Scroll down and select
Pin_N26. Instead of scrolling down the menu to find the desired pin, gan just type the name of the pin in the
Location box. Use the same procedure to assign inpub pin N25 and outpuyf to pin AE22, which results
in the image in Figure 27. To save the assignments made, elfiles> Save. You can also simply close the
Assignment Editor window, in which case a pop-up box will #sfou want to save the changes to assignments;
click Yes. Recompile the circuit, so that it will be compiled with therect pin assignments.

€ Assignment Editor

H g Categary: | Fin j @ Al || " Pin (b Tirning | # Logic Options |
=l + Information: | This cell specifies the pin name to which you want ko make an assignment, - Double-click to create a new assignment.
A Edit: b 4LYS |<<new>> |
Tao Location If0 Bank 1/ Standard General Function Special Function
1 LEnEWEE
< ¥

Figure 24. The Assignment Editor window.

Byl
B2

Figure 25. The drop-down menu displays the input and outpotas.
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Location |I,|’O Bank 1/ Standard General Function Special Fung

IN_1Z8] | LYTTL
PIN_Mz4 [OBanks  Row o L¥D51250 -~
PIN_MZ5 IO Bank 5 Row [jO LYDS5125n
PIM_M1 1/ Bank 2 Dedicated Clock. CLK1, LYDSCLEOR, Input
PIN_NZ 1/ Bank 2 Dedicated Clock. CLKD, LYDSCLEOp, Input
PIN_N9 [OBankz  Row o LYDS31p
PIN_N1G [OBankS  Row o LYDS110p
PIN_NZ0 [OBankS  Row o LYDS124p
PIN_NZ3 [OBankS  Row o LYDS126p, DPCLET/DOSORICO LR,
PIN_M24 IO Bank 5 Row [jO LYDS5126n
PIN_NZS [j0BankS  Dedicated Clack  CLE4, LYDSCLEZR, Input

I/C Bank 5 Dedicated Clock. CLKS, LV !

PIN_P1 If0 Bank 1 Dedicated Clock. CLK3, LVDSCLE LR, Input
PIN_PZ If0 Bank 1 Dedicated Clock. CLKZ, LVDSCLE1p, Input
PIN_P3 [oBankl  RowIjo LYDS26p, DPCLEL/DOSIL/CO1LE
PIN_P4 [oBankl  RowIjo LYDS26n
PIN_P& [oBankl  RowIjo LYDS22n
PIN_P7 [oBankl  RowIjo LYDS22n
PIN_P9 [OBankz  Row o LYDS31n
PIN_P17 IJO Bank & Row [jO LYDS5130n
PIN_P18 IO Bank 5 Row [jO LYDS5110n L

Figure 26. The available pins.

€ Assignment Editor* - 0]
g Category: | Fin j @ All | " Pin (b Tirning | # Logic Options |
=l + Information: | This cell specifies the pin name to which you want to make an assignment, - Double-click ko create a new assignment.
|
A Edit: b 4LYS |<<new>> |
|T0 Location If0 Bank 1/ Standard General Function Special Function
1 |1 PIN_NZ6 5 LYTTL Dedicated Clack CLKS, LYDSCLEZn, Ir
z |2 PIN_NZS 3 LYTTL Dedicated Clack CLK4, LYDSCLEZp, Ir
3 L F PIN_AEZZ 7 LYTTL Column I LYDS5155n
4 LENEN
< ¥

Figure 27. The complete assignment.

The DE2 board has fixed pin assignments. Having finished osigriethe user will want to use the same
pin assignment for subsequent designs. Going through theedure described above becomes tedious if there
are many pins used in the design. A useful Quartus Il featlwe/sithe user to both export and import the pin
assignments from a special file format, rather than credtiegn manually using the Assignment Editor. A simple
file format that can be used for this purpose isthenma separated value (CS\gfmat, which is a common text
file format that contains comma-delimited values. This filefat is often used in conjunction with the Microsoft
Excel spreadsheet program, but the file can also be createalyusing any plain ASCII text editor. The format
for the file for our simple project is

To, Location
x1, PINLN26
X2, PINLN25
f, PIN_LAE22

By adding lines to the file, any number of pin assignments eatrbated. Sucbsvfiles can be imported into any
design project.

17



If you created a pin assignment for a particular project, gani export it for use in a different project. To see
how this is done, open again the Assignment Editor to reaelwthdow in Figure 27. Now, seleElle > Export
which leads to the window in Figure 28. Here, the fifght.csvis available for export. Click ofxport. If you
now look in the directoryntrotutorial, you will see that the fildight.csvhas been created.

Export §|
Save in: | ) introtutarial ﬂ £ B
Db

File name:

Save as type: |Eomma Separated Yalue File [* cav] j Cancel

Figure 28. Exporting the pin assignment.

You can import a pin assignment by choosigsignments > Import Assignments. This opens the dia-
logue in Figure 29 to select the file to import. Type the namtheffile, including theesvextension and the full
path to the directory that holds the file, in the File Name bod pressOK. Of course, you can also browse to
find the desired file. For convenience, all relevant pin assignts for the DE2 board are given in the file called
DE2 pin_assignment.csin the directoryDE2 tutorials\designfiles which is included on the CD-ROM that ac-
companies the DE2 board and can also be found on Altera’s DHPpages.

Import Assignments @

Specify the source and categories of azsignments to import. Click LogicLock Import File Assignments
to zelect LogicLock Import File[z].

Aszsignment source
| L] Lo |

* File name:

" Use LogicLock Import File Assignments 4

[v Copy existing assignments into light.gsf bak before imparting

| Cancel |

Figure 29. Importing the pin assignment.

6 Simulating the Designed Circuit

Before implementing the designed circuit in the FPGA chiptlom DE2 board, it is prudent to simulate it to
ascertain its correctness. Quartus Il software includésalation tool that can be used to simulate the behavior
of a designed circuit. Before the circuit can be simulatet, hecessary to create the desired waveforms, called
test vectorsto represent the input signals. It is also necessary tafgpelsich outputs, as well as possible internal
points in the circuit, the designer wishes to observe. Thwikitor applies the test vectors to a model of the
implemented circuit and determines the expected respdtisavill use the Quartus Il Waveform Editor to draw
the test vectors, as follows:

18



1. Open the Waveform Editor window by selectifige > New, which gives the window shown in Figure 30.
Click on theOther Files tab to reach the window displayed in Figure 31. Chodsetor Waveform File
and clickOK.

New E3

Device Design Files | Software Files | Other Files |

Block Diagram/Schematic File
EDIF File

Yerilog HDL File

WHDL File

Ok | Cancel |

Figure 30. Need to prepare a new file.

New %]

Device Design Filesl Software Files  Other Files |

AHDL Include File
Block Symbal File
Chain Description File

Hexadecimal (Intel-Format) File
Memony Initialization File
SignalTap Il File

Tcl Script File

Text Fil

Ok | Cancel |

Figure 31. Choose to prepare a test-vector file.

2. The Waveform Editor window is depicted in Figure 32. Sédeeflle under the namleght.vwf, note that this
changes the name in the displayed window. Set the desiradation to run from 0 to 200 ns by selecting
Edit > End Time and entering 200 ns in the dialog box that pops up. Sele&tiagy > Fit in Window
displays the entire simulation range of 0 to 200 ns in the wimdas shown in Figure 33. You may wish to
resize the window to its maximum size.

19



Rilight .wwf =1 &3

Master Time Bar.| 1415 ns j_’lPUinter.| 1.0ns Interval | -13.18 ns Stan.‘ End.|

ps 1D.ID ns 20 ID ns |
Mame 1415 ns

|

[ | | KX =

Figure 32. The Waveform Editor window.

R light.vwf* [_[o]x]
Master Time Elar:| 1415 ns J_>| Pointer:| 4.87 ns Interval:| 9.28 ns Start| End:|
ps 4D|Dns BDIDns 1ZDID ns 1EDID ns ZDDDHSI
MNarme 1416 ns

o

[« | i

Figure 33. The augmented Waveform Editor window.

3. Next, we want to include the input and output nodes of theudito be simulated. Clicledit > Insert
Node or Bus to open the window in Figure 34. It is possible to type the nae signal (pin) into the
Name box, but it is easier to click on the button labelextle Finder to open the window in Figure 35. The
Node Finder utility has a filter used to indicate what type ed@s are to be found. Since we are interested
in input and output pins, set the filter Rins: all. Click theList button to find the input and output nodes as
indicated on the left side of the figure.

Insert Node or Bus [ x|

MName I [0]:4 I
Type: [inpuT | Cancel |

Value type: |9'LEVB‘ 2 NodeFinder. |
Radix [ Binary |
Bus width: I1

Startindex: ID

™ Display gray code count as hinans count

Figure 34. The Insert Node or Bus dialogue.
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Node Finder X

Mamed: |i j Filter: |Pins: all j Custamize... | List Q QK |
Lock in: jJ V' Include subentities | Cancel |
Modes Found: Selected Nodes:
Mame Aszzignments | Tupe ¥ | Mame Aszsighments | Tupe
I f PIN_&E22 Output s 9 [lightl1 PIN_N26 Input
| PIN_MNZE Input B lightlx2 PIN_MNZ5 Input
2 PIN_N25 Input < L lightlf PIN_&E22 Output
< ¥ < < ¥

Figure 35. Selecting nodes to insert into the Waveform Edito

Click on thex1signal in the Nodes Found box in Figure 35, and then clicktfsign to add it to the Selected
Nodes box on the right side of the figure. Do the samexfandf. Click OK to close the Node Finder
window, and then cliclOK in the window of Figure 34. This leaves a fully displayed Wave Editor
window, as shown in Figure 36. If you did not select the noddhé same order as displayed in Figure 36,
it is possible to rearrange them. To move a waveform up or dowime Waveform Editor window, click on
the node name (in the Name column) and release the mousa&biitte waveform is now highlighted to
show the selection. Click again on the waveform and drag dngiown in the Waveform Editor.

B light.wwf¥ M=l 3
Master Time Elar| 1415 ns i Pomter:| 35.85ns Interval:| 21.7ns Start| End |

ps |

Mame 1415 ns
|

[ x1
=] e
I
« ol | 2

Figure 36. The nodes needed for simulation.

4. We will now specify the logic values to be used for the infighalsx1 andx2 during simulation. The logic
values at the outpdtwill be generated automatically by the simulator. To malesaiy to draw the desired
waveforms, the Waveform Editor displays (by default) \atiguidelines and provides a drawing feature
that snaps on these lines (which can otherwise be invokebdysingview > Snap to Grid). Observe also
a solid vertical line, which can be moved by pointing to it Bmd dragging it horizontally. This reference
line is used in analyzing the timing of a circuit; move it teetime = 0 position. The waveforms can be
drawn using the Selection Tool, which is activated by seigdhe iconk in the toolbar, or the Waveform
Editing Tool, which is activated by the icc#2 .
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To simulate the behavior of a large circuit, it is necessagpply a sufficient number of input valuations and
observe the expected values of the outputs. In a large tit@inumber of possible input valuations may
be huge, so in practice we choose a relatively small (buesspntative) sample of these input valuations.
However, for our tiny circuit we can simulate all four inpwluations given in Figure 12. We will use four
50-ns time intervals to apply the four test vectors.

We can generate the desired input waveforms as follows.k @licthe waveform name for thel node.
Once a waveform is selected, the editing commands in the MfawxeEditor can be used to draw the desired
waveforms. Commands are available for setting a seleage@lsio 0, 1, unknown (X), high impedance (2),
don’t care (DC), inverting its existing value (INV), or deifig a clock waveform. Each command can be
activated by using thEdit > Value command, or via the toolbar for the Waveform Editor. The Euknu
can also be opened by right-clicking on a waveform name.

Setx1to 0 in the time interval 0 to 100 ns, which is probably alreadyby default. Next, setlto 1 in the
time interval 100 to 200 ns. Do this by pressing the mouseeastart of the interval and dragging it to its
end, which highlights the selected interval, and choodiegagic value 1 in the toolbar. Make& = 1 from

50 to 100 ns and also from 150 to 200 ns, which correspond<ettriith table in Figure 12. This should
produce the image in Figure 37. Observe that the oufpstdisplayed as having an unknown value at this
time, which is indicated by a hashed pattern; its value vélbietermined during simulation. Save the file.

B light.vwf* CBEX

Master Time Bar: 0ps 1| ¥| Painter: 128.07 nz Interval: 128.07 nz Start: End:
0 pz 4D.ID nz SD.ID nz 12DiD nz 1BDiD nz 200.0 n4
Mame 0ps
i
| | «1 J
I IEEREREEEN EEEEEEEEEN
EI
< ¥

Figure 37. Setting of test values.

6.1 Performing the Simulation

A designed circuit can be simulated in two ways. The simplest is to assume that logic elements and intercon-
nection wires in the FPGA are perfect, thus causing no delgydépagation of signals through the circuit. This
is calledfunctional simulation A more complex alternative is to take all propagation dglayo account, which
leads tatiming simulation Typically, functional simulation is used to verify the fetional correctness of a circuit
as it is being designed. This takes much less time, becaasgrtiulation can be performed simply by using the
logic expressions that define the circuit.

6.1.1 Functional Simulation

To perform the functional simulation, sele&ssignments > Settings to open the Settings window. On the left
side of this window click orSimulator to display the window in Figure 38, chooBanctional as the simulation
mode, and clickOK. The Quartus Il simulator takes the inputs and generatesutpts defined in thight.vwf
file. Before running the functional simulation it is neceys@ create the required netlist, which is done by se-
lecting Processing > Generate Functional Simulation Netlist. A simulation run is started birocessing >

Start Simulation, or by using the ico®.. At the end of the simulation, Quartus Il software indicatesuccessful
completion and displays a Simulation Report illustrateéigure 39. If your report window does not show the
entire simulation time range, click on the report windoweétest it and choos¥iew > Fit in Window. Observe
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Categony:

General
Files
User Libraries
Device
Timing Reguirements & Options
= EDA Tool Settings
Design Entry/Synthesis
Simulation
Tirning Analysis
Board-Level
Farmal Werification
Physical Synthesis
= Compilation Process Settings
Early Timing Estimate
= Analysis & Synthesis Settings
= Fitter Settings
Physical Synthesis Optimizations
Timing Anakyzer
Design Assistant
SignalTap |l Logic Analyzer
SignalProbe Settings
Simulator
= PowerPlay Power Analyzer Settings
= Software Build Setings
HardCopy Settings

that the outpuy is as specified in the truth table of Figure 12.

Select options for simulation. Note; the availability of some options depends on the current device family.

Simulation mode:

Simulation input |

Simulation period

" Fun simulation until all vector stimul| are used
ns z

¥ Automatically add pins to simulation output wewveforms

I Check outputs

I™ Setup end hold e vialation defection

¥ Simulation coverage reporting

€ End simulation at

= Glith detecticn

I Owerwrite simulation input file with simulation results

WPCare Transacton Modsl Fle Name: |

Signal activity output for power analysis

™ Generate Signal Activity File

Filename:  [ightsst

Bignal Activity il Dptions..

Cancel

o]

i

Figure 38. Specifying the simulation mode.

Simulation Waveforms

Master Time Bar: 0ps 1| ¥| Painter: 196.84 nz Interval: 196.84 nz Start: End:
0 pz 4D.ID nz SD.ID nz 12DiD nz 1BDiD nz 200.0 n4
Mame 0ps
i
> «1 J
I INEEEEEEEN s EEEEEnEnensnini Sl pnnnnnnnnn
@] f 1 IS N S N O
< ¥

Figure 39. The result of functional simulation.

6.1.2 Timing Simulation

Having ascertained that the designed circuit is functigrarrect, we should now perform the timing simulation
to see how it will behave when it is actually implemented ia thosen FPGA device. Selgkssignments >
Settings > Simulator to get to the window in Figure 38, choo$ening as the simulation mode, and cli€.

Run the simulator, which should produce the waveforms inufegl0. Observe that there is a delay of about 6
ns in producing a change in the sigrfafrom the time when the input signals; andzs, change their values.
This delay is due to the propagation delays in the logic efgrard the wires in the FPGA device. You may also
notice that a momentary change in the valug pfrom 1 to 0 and back to 1, occurs at about 106-ns point in the
simulation. Thigglitch is also due to the propagation delays in the FPGA device Usecehanges im; andxs
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may not arrive at exactly the same time at the logic elemetitgbnerateg.

Simulation Waveforms

Master Time Bar: 0ps 1| ¥| Painter: B98 pz Interval: B98 pz Start: End:
0 pz 4D.ID nz SD.ID nz 12DiD nz 1BDiD nz 200.0 n4
Mame 0ps
i
> «1 J
I INEEEEEEEN e nEEEEEREnansni NSl e nnnnnnn
|t I [ N N I R
< ¥

Figure 40. The result of timing simulation.

7 Programming and Configuring the FPGA Device

The FPGA device must be programmed and configured to impletmedesigned circuit. The required configura-
tion file is generated by the Quartus Il Compiler's Assembiedule. Altera’s DE2 board allows the configuration
to be done in two different ways, known as JTAG and AS modee cdmfiguration data is transferred from the
host computer (which runs the Quartus 1l software) to therdbdy means of a cable that connects a USB port
on the host computer to the leftmost USB connector on thedbdar use this connection, it is necessary to have
the USB-Blaster driver installed. If this driver is not aldy installed, consult the tutori@etting Started with
Altera’s DE2 Boardfor information about installing the driver. Before usidgetboard, make sure that the USB
cable is properly connected and turn on the power supplycbwin the board.

In the JTAG mode, the configuration data is loaded directly ihe FPGA device. The acronym JTAG stands
for Joint Test Action Group. This group defined a simple waytésting digital circuits and loading data into
them, which became an IEEE standard. If the FPGA is configuréais manner, it will retain its configuration
as long as the power remains turned on. The configurationnrefion is lost when the power is turned off. The
second possibility is to use the Active Serial (AS) mode.hiis tase, a configuration device that includes some
flash memory is used to store the configuration data. Quarsaftivare places the configuration data into the
configuration device on the DE2 board. Then, this data isddaato the FPGA upon power-up or reconfiguration.
Thus, the FPGA need not be configured by the Quartus Il softifaine power is turned off and on. The choice
between the two modes is made by the RUN/PROG switch on thelldB2l. The RUN position selects the JTAG
mode, while the PROG position selects the AS mode.

7.1 JTAG Programming

The programming and configuration task is performed asv@lloFlip the RUN/PROG switch into the RUN
position. Selecilools > Programmer to reach the window in Figure 41. Here it is necessary to §péoe
programming hardware and the mode that should be used. Hlrestdy chosen by default, select JTAG in the
Mode box. Also, if the USB-Blaster is not chosen by defauless theHardware Setup... button and select the
USB-Blaster in the window that pops up, as shown in Figure 42.
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i light.cdf

éa Hardware Setup... USE-Blaster [USE-0] Mode: [JTAG | Progress 0%

W Start File ‘Device ‘Ehecksum Usercode E[oongfi[gaLT; Werify Elﬁggk ‘ Examine
light. saf EP2C3I5FET2 O02F7EEE FFFFFFFF

*E'ﬂ Auto Detect

& Add File...

|

| »

Figure 41. The Programmer window.

Observe that the configuration fiight.sofis listed in the window in Figure 41. If the file is not alreadistéd,
then click Add File and select it. This is a binary file produced by the Compil&ssembler module, which
contains the data needed to configure the FPGA device. Thasgh.sofstands for SRAM Obiject File. Note
also that the device selected is EP2C35F672, which is theAFiR®ice used on the DE2 board. Click on the
Program/Configure check box, as shown in Figure 43.

Hardware Setup

X

Hardware Seftings IJTAG Settings]

Select a programming hardware getup to use when programming devices. This programming
hardware zetup applies only ta the current programmer window.

Currently selected hardware:

Available hardware items:

Hardware Server | Fart | Add Hardware...
USE-Blaster Local UsE-n

Cloze

Figure 42. The Hardware Setup window.

i light..cdf CEX

&, Hardware Setup...| | USE-Blaster [USB-0] Made: [1TAG 2| Eremess 0%

W Start File Device Checksum Usercode E[oongfi[gaLT; Werify Elﬁggk Examine
light. zof '2C3RFET2 7EEE EFFEFFEF

*E'ﬂ Auto Detect

¥ Delete

& Add File...

li= Change File...

|

| »

Figure 43. The updated Programmer window.
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Now, pressStart in the window in Figure 43. An LED on the board will light up wihéhe configuration data
has been downloaded successfully. If you see an error egpytQuartus Il software indicating that programming
failed, then check to ensure that the board is properly pesen.

7.2 Active Serial Mode Programming

In this case, the configuration data has to be loaded into dhéguiration device on the DE2 board, which is
identified by the name EPCS16. To specify the required cordtgn device selecAssignments > Device,
which leads to the window in Figure 44. Click on tBevice & Pin Options button to reach the window in
Figure 45. Now, click on th€onfiguration tab to obtain the window in Figure 46. In the Configurationidev
box (which may be set to Auto) choose EPCS16 and &€k Upon returning to the window in Figure 44, click
OK. Recompile the designed circuit.

Settings - light X

Category:

General
- Files
- User Libraries [Current Project] Select the family and device you want to target for compilation.
- Device
i Timing Requirements & Options

Family: | Cyclone I L] Device & Pin Options..

[+ EDA Tool Settings
+ EDI‘nDIthDn F'roc:es.s Sett!ngs et
[+ Analysis & Synthesiz Settings ~ X ) L o
[ Fitter Seftings Auto device selected by the Fitter from the ‘Available devices' list
; Timing Analyzer (' Specific device selected in ‘Svailable devices' list
: Dresign Assistant .
1! SignalTap Il Logic Analyzer L
2 g!gnTIProbe Settings Available devices: Show in ‘Available devices' list
- Simulator
EPZCEF25ECT [4d d ;
[#- PowerPlay Power &nalyzer Settings EP2CEF256C8 EAd:::g:d} e Package: Any >
[+ Software Build Settings EP2CEF 25618 [Advanced) : 2 =
2 M ardiC ey Seltings EP2C80208C7 [Advanced) Finsolnt. | Jany
EP2CB0208CE [4dvanced) ; r—L]
EP2CA020818 (Advanced) SlEEE ) B
EP2CAT144CE [Advanced) Core voltage: 1.2
EPZCAT144C7 [Advanced) .
EP2CAT144C8 [Advanced) | W Show advanced devices
EPZCAT 14418 [Advanced) -
EP2C20F256CE s S
EP2C20F 25607 [~ Migration compatibility
EP2C20F256C8 0 migration devices selected
EP2C20F 25618
EP2C20F484CE = Migration Devices. ..
EP2C20F484C7
EP2C20F484C8
EP2C20F484I8
EP2C35F484C6
EP2C35F484C7
EP2C35F484C8
EPZC35F484/8

ok | Cancel ‘

Figure 44. The Device Settings window.
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Device & Pin Options EI

Dwal-Purpoze Ping ] WVoltage ] Fin Placement ] Error Detection CRC ]
General l Configuration ] Programming Files ] Unuzed Fins ]

Specify general device options. These options are not dependent on the configuration
scheme.

Options:

Releaze clears before tri-states
[C1Enable user-supplied start-up clock [CLEUSR]
[C1Enable device-wide rezet [DEY_CLRN]
[C1Enable device-wide output enable [DEY_DE]
[C1Enable IMIT_DOME output

[~ Auto usercode

JTAG uzer code [32-bit hexadecimal,  |FFFFFFFF

Drescription:

Diirects the device to restart the configuration process automatically if a data error iz
encountered. If this option is turned off, you must externally direct the device to
restart the configuration process if an ermor ocours.

Reset

Figure 45. The Options window.

Device & Pin Options EI

Dwal-Purpoze Ping ] WVoltage ] Fin Placement ] Error Detection CRC ]
General Configuration l Programming Files ] Unuzed Fins ]

Specify the device configuration scheme and the configuration device.

Configuration scheme: |Active Serial [can use Configuration Device] j
Configuration mode: | J

Configuration device
v Usze configuration device: Auto j

Auto
EPC51
EPCS4

v Generate compressed bitstreams |EPCSE4

Drescription:

Specifies the configuration device that you want to uge as the means of configuring
the target device.

Reset
(] 8 | Cancel |

Figure 46. Specifying the configuration device.

The rest of the procedure is similar to the one describedafimthe JTAG mode. Selebols > Program-
mer to reach the window in Figure 41. In the Mode box selective Serial Programming. If you are changing
the mode from the previously used JTAG mode, the pop-up bdigare 47 will appear, asking if you want to

27



clear all devices. Clickes. Now, the Programmer window shown in Figure 48 will appeaak®lsure that the
Hardware Setup indicates the USB-Blaster. If the configomdtle is not already listed in the window, presdd
File. The pop-up box in Figure 49 will appear. Select the lidgat.pofin the directoryintrotutorial and click
Open. As a result, the configuration filght.pofwill be listed in the window. This is a binary file produced by
the Compiler's Assembler module, which contains the dataettoaded into the EPCS16 configuration device.
The extensionpofstands for Programmer Object File. Upon returning to thegRnmmer window, click on the
Program/Configure check box, as shown in Figure 50.

Quartus 11 %]

& Some devices in current device list cannot be added to selected programming mode Active Serial Programming. Do
yoll want to clear all devices in current device list and switch to selected mode?

fes N |

Figure 47. Clear the previously selected devices.

i light.cdf*

éa Hardware Setup...| | USB-Blaster [USE-0] Mode: | Active Serial Programming | Progress: 0%

File Device ‘ Checkzum Uszercode E[oongfi[gaLT; Werify Elﬁggk Examine
& Add File...
2 Add Device..

< ¥

Figure 48. The Programmer window with Active Serial Prognaing selected.

Select Programming File §|
Lok in: |_} introtutarial ﬂ EF Ed-

b

File name: |Iight.p0f
Files of type: | POF Files [*.pof) =] Cancel

Figure 49. Choose the configuration file.
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T AES

cEa Hardware Setup | | U5B-Blaster [USE-0] Mode: |Active Serial Programming + | Progress: 0%
W Start File Device Checksum Usercode E[oongfi[gaLT; Werify Elﬁggk Examine

B2 light.pof

Page. e o o o o

35 3

¥ Delete

li= Change File...

Figure 50. The updated Programmer window.

Flip the RUN/PROG switch on the DE2 board to the PROG positieressStart in the window in Figure
50. An LED on the board will light up when the configurationalhas been downloaded successfully. Also, the
Progress box in Figure 50 will indicate when the configuratiod programming process is completed, as shown
in Figure 51.

i light.cdf*

éa Hardware Setup...| | U5B-Blaster [USE-0]

" Frogram/
File Configure

Wb Start

B2 light.pof
L-Page_0

¥ Delete

li= Change File...

<

| »

Figure 51. The Programmer window upon completion of prognamg.

8 Testing the Designed Circuit

Having downloaded the configuration data into the FPGA dewou can now test the implemented circuit. Flip
the RUN/PROG switch to RUN position. Try all four valuatiooisthe input variables; andzs, by setting the
corresponding states of the switchg€B/; and.SW,. Verify that the circuit implements the truth table in Figur
12,

If you want to make changes in the designed circuit, firstelt®e Programmer window. Then make the
desired changes in the VHDL design file, compile the cirang program the board as explained above.
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